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2 Introduction
These operating instructions describe the installation of the TFA Nexus software and its
use.
The software enables the operation of the TFA Nexus or TFA Sinus weather center via the
USB interface of your PC.
The weather station must be connected to the PC by means of a suitable USB connection
cable (as delivered with the accessories) or any other suitable USB cable.
The software performs the program-controlled reading of data from the memory of the
weather station and from the current display. It also can read and write a few set values.
The values read in are saved, displayed in a table or diagrams and the recorded data file
(”NexusOrg.dbf” resp. "SinusOrg.dbf") can also be read by means of some standard
software (i.e. by use of Microsoft Excel).
The data, currently shown with the weather station display, are also displayed in a window
within the program (the values are refreshed with a maximum delay of about two minutes
against the data, shown by the station itself).
The software exclusively operates with the series TFA Nexus or TFA Sinus weather
station. With basic accessories only one Thermo-/Hygro sensor is included, but up to five
Termo-/Hygor sensors (Chn1 to Chn5) may be used by the weather station and are
supported by the software.
The representation of pictures, shown within this description, might slightly differ from
pictures used in the program. The description always uses the complete set of five
sensors.
The data measured by the weather station and transmitted to the program are:
-

-

the current indoor temperature and humidity (°C, %r.H.)
the current outdoor temperature and humidity of up to five sensors (°C, %r.H.)
the current raincount sample, yesterday, last week, last month (mm)
the current wind direction, the average wind speed and the gust speed (°, mph)
the current wind chill (°C)
the absolute airpressure on sea level (mBar)
the statistical data of air pressure within the last 24 hours
the current day and month (DD/MM)
the current weekday name and the time (hh:mm) of the last sample
Minima and maxima with:
- Indoor temperature and humidity (°C, %r.H.)
- Outdoor temperature and humidity for up to five sensors (°C, %r.H.)
- Maxima of wind speed and gust speed (mph)
The weather forecast (State 1 to 7)
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These values above also are stored to the internal memory of the weather station (up to 3445 datasets).
The following data are displayed with the weather station but not transmitted to the program:
·
·
·
·
·
·
·
·
·

the current indoor dewpoint (td/°C)
the current outdoor dewpoint (td/°C)
the current moon phase
the time for sunrise and sunset (hh:mm)
the temperature of the wind sensor (°C)
the locally measured air pressure (mBar)
the raincount of last hour and last 24 h (mm)
the current time
the current year

Therefore the following data are calculated by the program:
·
·
·
·
·
·
·
·
·

the indoor dewpoint (calculated from temperature and humidity as td/°C or td/°F)
the outdoor dewpoint (calculated from temperature and humidity as td/°C or td/°F) for up to five
sensors
the moon phase (% of the visible moon surface)
the times for sunrise, sunset, high noon and length of sunshine (hh:mm)
the (recalculated) temperature of the wind sensor (°C or °F)
the (recalculated) local air pressure, depending on the station altitude
the raincount for the last hour and the last 24 hours (mm)
the time (PC system time)
the (recalculated) date (calculated from month, day and weekday)

*) There might be slight differences between the values shown on the weather station display and that,
calculated by the software. The deviations are the result of different algorithms and the available number
precision used in the weather station and the software (this results in about 2 min deviation with the sunrise
and sunset times) or it may be an effect of the time delay of data shown on the station and that, transmitted
to the software against all recalculated data. In most cases the deviations should be negligable.
The values displayed in the program are the measured values themselves, the recalculated values, the
appropriate tables and the diagrams and histograms for the different physical units.
Some device settings are available within the program, other settings must be taken directly at the device.
Be careful on changing the time zone settings or the device altitude setting:
!!!Change these values only upon mature consideration!!!
·

Changing the local settings (citycode, latitude, longitude, time zone) may result in large
differences of the time displayed and the times calculated for sunrise and sunset. This also may
result in irreversible changes of the date and time information, recorded with the acquired data.

·

Changes of the station altitude setting also changes the air pressure values displayed and
recorded. Original values can not be recalculated, because the station altitude is not saved with
each record.

The program reads the data from the weather station and saves the data to two different files.
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1) The file ”Mirror.mem” holds a 1:1 copy of all data, currently available with the memory of the weather
station. It is used, to minimize the time for reading data from the station (only changes must be read to
update the file ”Mirror.mem”). Do not try to edit this file! This may lead to serious problems on operating
the software. If this file is deleted, it is created again (needs about eight to nine minutes for a complete
read) with the next transmission cycle. The first read operation after starting the program normally
needs a time between a few seconds up to a few minutes, depending on the amount of changes since
last read operation. While the program is running, further update read operations need only a few
seconds.
2) The file ”NexusOrg.dbf” (resp. "SinusOrg.dbf") holds all data ever read. New data always are appended
at the end of the file. The format is ”dBase III”, that is well distributed for database applications. This
format also can be read by using Microsoft Excel. But never save the original file using a third party
software, even not by using Excel. This is, because of some file settings may be damaged and this may
lead to serious problems on operating the software. To edit, always use a copy of this file.
.

2.1 Additionally recommended manuals
For easy and quick installation and commissioning of the TFA Nexus software on your PC operating
system, also refer to the following manuals:
·
·

The Microsoft WindowsÒ User Guide for your operating system
The operating instructions for the device used

2.2 System requirements
PC
Hard disk

PC/AT compatible with 80486 processor or higher
at least 8 MB free capacity for installation of software, enough space for
recording the data (depends on acquisition interval)
Memory
at least 8 MB free capacity
Graphics
resolution at least 1024 x 768 or higher
Mouse
MS-WindowsÒ compatible mouse or similar device
WindowsÒ 32-Bit versions as from Win98 and later (Win 98/ME/XP, Win NT/2000)
USB
one USB port, suitable HID driver (standard with the operating systems)
Cable
connection cable (delivered with accessories)
Weatherstation
A device of the series TFA Nexus or TFA Sinus

2.3 Windows® installation
A WindowsÒ 32 bit operating system (Win98 and later) must be installed on your PC. A
safe function of the operating system installed is necessary to guarantee proper
functioning of the TFA Nexus software.
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2.4 Content of the software package
The software package contains the following components
·

The TFA Nexus software CD contains
· The installation program english/german
· The dual language program version english/german
· The TFA Nexus helpfiles english/german and manuals english/german (.pdf format)

2.5 Connection of a device
Connect your properly operating weather station to a free USB port using a suitable USB
connection cable (accessory). At the very first time, the operating system detects a new
hardware and searches for a suitable driver. The driver is part of the operating systems
(mentioned above) and is not a part of the TFA Nexus setup CD. Please follow the
instructions of the operating system. Normally the system searches for a HID (Human
Interface Device) driver and installs it. Later on, the driver is preinstalled with every system
start. If this fails, leave the weather station connected and restart your PC. After that the
driver should be found and should be installed automatically and safetly for future use.
Advices for operation after lost connection:
Sometimes, in case of stronger electromagnetical disturbances (as they are coming i.e. by
switching neon lights, motors, other electrical devices or by operation of handys within the
immediate environment) it may happen, that the USB connection is lost while operation, or
sometimes between the minutely repeating read cycles.
Reestablish the connection
In this case it normally helps, to disconnect the USB cable and reconnect it again. There is
no other easy way, to reestablish the connection by any standard tool, coming with the
windows operating system.
But, for this case, to reestablish the connection by software, an external program called
"devcon.exe" is provided by Microsoft. The software TFA_Nexus can use this tool, to
reestablish the connection automatically, if it is installed to the TFA_Nexus program
directory (as default C:\Programs\TFA_Nexus\).
Using the tool "Devcon.exe" to reestablish the connection
The new Version of TFA_Nexus (since version 1.3) checks the accessability to
"devcon.exe". In case of a lost USB connection the software TFA_Nexus searchs for the
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existence of "devcon.exe" in its program directory and, if available, it automatically starts
devcon.exe by transmitting some device depending operation parameters and then
executes it. After execution normally the weatherstation will be reconnected successful to
the USB port.
This tool is not allowed to be redistributed, so it is nor a part of the installation procedure
neither a part of the distributed TFA_Nexus disk. But it can be downloaded from the
microsoft® website for free.
To download this tool, follow the link:
http://support.microsoft.com/kb/311272/de.
If you're looking for another description in your language please search the internet or the
microsoft® support site for the presence of any similar link to devcon.exe.
After download "Devcon.exe" has to be installed to the program directory, where also the
Software "TFA_Nexus.exe" is located. This, by default, is the directory "C:\Programs
\TFA_Nexus\...".
TFA_Nexus executes the commandline program, simply using the following parameters:
· to stop the connection:
· to start the connection:
· to restart the connection:

Devcon disable usb\VID_1130*
Devcon enable usb\VID_1130*
Devcon restart usb\VID_1130*

2.6 Installation of the TFA Nexus software
Before the installation of the TFA Nexus software please connect your weather station as described
above. The software operates only in case of a properly installed HID driver. Please be sure, the
values displayed by the station are up to date (i.e. time is synchronized, the measurement values
are displayed as expected, no sensor has a missing link), this minimizes possible problems on start
up.
If so, you can proceed and install the software now!
The TFA Nexus software is supplied on a CD.
a) Insert the CD in your CD-ROM drive. Most systems will detect the CD automatically and start the
installation routine. If not, start the installation via the task bar by selecting Start->Run->[your CD-ROM
drive]->Setup.exe.
b) Now, follow the instructions of the installation routine. During the installation a target directory
Programs\ TFA_Nexus will be suggested. You can change the target directory as you please.
c) The installation routine will create a program group for the directory selected and a program symbol
with the name "TFA Nexus".
d) If you want to run the program later, double-click on the program symbol "TFA Nexus" on your desktop
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or select Start->Programs->[click on: TFA Nexus].
e) In addition to the actual program "TFA_Nexus.exe" the CD contains the online manual(s), the help
file(s) and several setup configuration files.

2.7 First use of the software / preparations
Before you start the software the very first time, please be sure the weather station has no
missing link to any sensor connected. All values displayed should be in an expected
condition. The time should automatically have been synchronized to your local time.
Starting the software, without having checked these conditions before, may lead to several
problems on further use.
If these precautions are checked successfully:
Start the software by double-clicking on the ”TFA” symbol
selecting “Start->Programs->TFA Nexus".

on your desktop or by

At the first start of the software, all data from the weather station must first be acquired. It
is necessary, that the weather station is connected and it is ready to operate. The first
read in of data takes about 8 minutes.
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Start the action by pressing the button “Yes”. From that moment on, you’ll need a little bit
of patience. Please do not operate the program, while the software acquires data from the
weather station.
2.7.1 Basic functions
2.7.1 Basic functions
On the very first start, the program tries to get a successfull connection to the weather
station and prepares some data directories and files. For an easy startup you should follow
the instructions mentioned above. The software is designed to operate with original TFA
Nexus or TFA Sinus devices only. If you have connected an original TFA device, but you
get problems in any way, please feel free to contact the TFA hotline for relief.
The program should detect your weather station within the first few seconds after start.
From this moment on a progress bar is used to display the running transmission and a little
box beneath is blinking. First time (and only the first time) it needs up to about nine
minutes to perform a complete read. Please have patience! Later readings are essentially
faster and will take from a few seconds up to a part of this nine minutes, depending on the
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update cycle and the acquisition interval selected.
You do not need to save any data. The program automatically saves the current results to
the file ”Mirror.mem” at directory ”...\Mirror” and appends the datasets, last updated, to the
file ”NexusOrg.dbf” (resp. "SinusOrg.dbf") at directory ”...\Data”. These files are updated
on any read in of new valid datasets. The file ”Mirror.mem” is a binary data format – a copy
of the internal EEprom memory of the weather station – unable to be opened with any
existing program for successful results. The original database is a file, using the ”dBase III”
data base format. This can be read using i.e. MicrosoftÒ ExcelÒ (but, please open only for
read – do not edit and save it again). See chapter 5.1 for details.
Never save the original “NexusOrg.dbf” or "SinusOrg.dbf" using third party programs.
Please always take a copy for edit operations on this file.
You may use the software in it’s Online mode (weather station connected and ready to
use) mode or in an Offline mode (no device connected). To use the Offline mode, data
must have been read in at least once a time before, to get available. In Offline mode you
can see all the data, acquired before, but no current readings.
View at Online mode:
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View at Offline mode:
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Using the Offline mode, instead of the green Online display the red Offline display appears
in the window “Data transmision” at the left beneath the progress bar.
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3 Working with the software TFA Nexus
This chapter describes the organization of the software TFA Nexus and provides
information on how to use it. We assume that the user knows how to work with a PC and
is familiar with the general functions of the WindowsÒ operating system.
Organization of the user interface
The software is controlled via pull-down menus and registration cards for different
functions.

Menu bar:
The menu bar contains different groups of the program menu. Click on a group to open the
corresponding menu group. Here, you have further selection options.
Registration cards:
Below the menu bar you will find a card index for different display options of the
measurement values.
Display:
Display shows a virtual view of the device display. Here you will find all the values
as they are also visible on the display of the weather station. Additionally some
values are displayed as diagrams over about the last 24 hours. Regarding the
values displayed directly at the weather station, a time delay of up to about 2
minutes may occur.
Table:
Table shows values from the database for the selected period, sorted by date and
time, in a table view.
Diagrams:
Diagrams show values from the database for the selected period, selectable from a
range of different functions. A click to the card index changes to the desired
function.
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At the bottom of the window you will find a status bar with different program messages.

3.1 Using the program menu
Here, the menu group File, View and Help are available. In the following you will find a
short description of the function of the individual menu items:
Menu group File 15
Menu group View 15
Menu group Help 17
3.1.1 Menu group File

Read data from device
Language
Program settings
Device settings
Print
Quit

Used for start a manual read from the weather station
Used to select the desired language (comes to effect always after restart)
Used for edit program settings as available channels and physical units
Used for edit device settings (Basic settings of the weather station)
Used for preview and the printing of a hardcopy of the currently used diagram
Used for closing the program

3.1.2 Menu group View

Trend symbols
Station Min/Max values

Used to display a window, showing the used trend symbols
Shows the min/max values, hold by the station

3.1.2.1 Legend of symbols

This window displays the trend symbols and their declarations, used by the software
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3.1.2.2 Station Min/Max values

This window displays the minima and maxima for temperature and humidity, coming from
the indoor and the outdoor sensors. Also it displays the daily maxima for wind and gust of
the aneometer.

The minima/maxima of the sensors are resetted only by a reset of the device or a reset of
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the minima/maxima, using the device front panel.
The maxima of the aneometer are resetted every midnight.
3.1.3 Menu group Help

Help contents page (F1)
Shows the page concerning the chapter “contents”
Help chapters
Selection of help themes by chapters
Help index
Selection of help themes by a predefined index
Search via keyword
List of desirable keywords, found in the help file
... about TFA Nexus
Short info/adresses concerning the program TFA Nexus
Database Ceck and Repair
Starts an external program (TFA_Check.exe) to check and repair the database structure and data. Using this
tool, also databases from the same structure can be concatenated to
only one database file.
On starting the tool, the TFA software will be stopped and closed.
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While working with the tool, the TFA software should be keeped closed. Details
about the tool see chapter "6 Database Check and Repair" 55
After finishing the tool, the TFA software can be restarted using the button "Close
and restart the TFA software".

3.2 Using the registration card selection
Below the program menu you may select a desired card index, named as ”Display”, ”Table
” or ”Diagrams”.
3.2.1 Card index ”Display”
3.2.2 Card index ”Table”

19

19

3.2.3 Card index ”Diagrams”

20
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3.2.1 Card index ”Display”
After starting the program, always the view of registration card ”Display” is shown. This
view contains all the values as currently also shown in the display of the weather station
itself. A time delay of up to about two minutes may appear against the values, originally
displayed by the weather station: Background is: a) the weather station provides always
the latest data with a delay of about 30 sec and b) the program checks for updates only
once a minute. So, you may detect small deviations.

3.2.2 Card index ”Table”
If you click on the card index ”Table”, you will get the view of a data table. This table may
contain all data, ever read from the weather station . The data shown are the records (or
only a part) of the file ”NexusOrg.dbf”. The period, used to display the table, is the period
selected with the selection box in the upper right corner of the registration card.
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The column "Forecast" uses the numbering for the forecast symbols as follows:
0 - Heavy Snow
1 - Snow
2 - Heavy Rain
3 - Rain
4 - Cloudy
5 - Cloudy/Sunny
6 - Sunny

3.2.3 Card index ”Diagrams”
If you click on the card index ”Diagrams”, you will get an overview of different registration
cards, available to show data as diagrams, sorted by different functions. These diagrams
may contain all data, ever read from the weather station. The data shown are the records
(or only a part) of the file ”NexusOrg.dbf”. The period, used to display the desired diagram,
is the period selected with the selection box in the upper right corner of the registration
card.
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Within the view ‘Diagrams’ a few more registers are available to select different functions.
By a click to the switchbox within the legend a selection of measuring channels, to be
displayed, can be switched on or off. By a click to the switchbox ”3D” the visual
representation can be switched between flat or 3D (threedimensional). By a click to the
switchbox ”Full resolution” some more details are shown in the diagrams. To get a faster
refresh of the graphics, the standard setting (for periods of more than seven days) always
is a lower resolution.
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”Display”, ”Table” and ”Diagrams” always use the physical units as defined within the ”
Program settings”. On the first appearance of a diagram always an automatic scaling for
the values axis and the time axis is used as default. With new incoming data all data views
are refreshed automatically. The default period, to show the table and diagrams, always is
24 h. You may select between other predefined standard periods. The period currently
selected, automatically becomes valid for all diagrams and the table (Exception: Diagrams,
that are zoomed, will not be attached).

3.2.3.1 Line diagrams
To display the diagrams for temperature, humidity, dewpoint, wind chill, windspeed, wind
direction and air pressure the view ”Line diagrams” is used. The lines can be switched on
or off by clicking to the desired switchbox within the legend box. The selection is valid only
for the diagram just seen.
With line diagrams, the visible area can be moved or it can be zoomed by using the mouse
(see chapter 4.3.1 Mouse functions to operate diagrams). If a period is selected (by
moving the time axis or zoom), where no current value is visible at the right end of the time
axis, the automatic refresh is switched off, otherwise it is switched on again.
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There is also a 3D view available for line diagrams. The following views show the same
measurement results, but threedimensional.

3.2.3.2 Pie diagrams
To display the diagrams for distribution curves of wind speed or wind direction the view ”
Pie diagrams” is used. The lines can be switched on or off by clicking to the desired
switchbox within the legend box. The selection is valid only for the diagram just seen.
With pie diagrams, the visible area can not be moved and it can not be zoomed.
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There is also a 3D view available for pie diagrams. The following views show the same
measurement results, but threedimensional.

3.3 Basic Settings
For the weather station and the program some basic settings can be defined. The menues
for settings are startet from menu group ”File”, by clicking to ”Basic program settings” or ”
Basic device settings”. The basic program settings are saved automatically into the file
"TFA_Nexus.ini". The basic device settings are stored directly to the memory of the
weather station.
3.3.1 Basic program settings
3.3.2 Basic device settings

24

24

3.3.1 Basic program settings
From this point, the pysical units can be changed and a few sensor settings are available.
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3.3.1.1 Selection of physical units
3.3.1.2 Selection of Sensors

25

25

25

3.3.1.1 Selection of physical units
From this point, the pysical units, to be used by the program display, are defined. These
are the units for the station altitude, the air pressure, temperarures, humidity values,
dewpoints and for the speed of wind and gust. The settings made here, are only for the
use inside the program. These settings do not have any influence to any physical unit,
displayed at the weather station itsellf. The units displayed from the weather station, must
be preset by using the keys at the weather station directly (see TFA Nexus operation
manual).

3.3.1.2 Selection of sensors
From this point is defined, which sensors should be used within the program displays and
what color should be used on drawing the line diagrams. A description, i.e. the loaction of
a sensor, can be added as a note. The line color can be changed after clicking on the
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small color box and thereafter selecting a color from the appearing color pattern.

To accept the changes click on "Accept". The changes will be active immediately and will
be used as standard settings when you start the program again. To cancel the changes
click on "Cancel".

3.3.2 Basic device settings
From this point, some basic settings for the weather station are defined. The settings are
sorted on themes by some registration cards. These themes are the station altitude (to
adjust a correct display of air pressure), the citycode (geographical data for latitude and
longitude, time zone and DST mode) for the local city and a second one, alarm times,
limits for rain, wind and gust, the acquisition interval and a sample of status messages.
3.3.2.1 Citycode and geographic data 27
3.3.2.2 Station altitude 29
3.3.2.3 Time alarms 30
3.3.2.4 Limits for rain alarm and wind alarm
3.3.2.5 Acquisition interval 32
3.3.2.6 Status messages 33

31
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3.3.2.1 Geographical data / Citycode
Here you will find the currently used citycode and the appropriate geographical data, time zone and DST
mode. After clicking to ”Change local settings” or ”Change second city” a new window opens, where you
may edit these settings.
Be careful on changing the local settings!
The changing of local settings will have an effect directly to the internal timer of the weather station and
may change date and time information in an unexpected way. Starting from the moment, where the new
settings come into effect, all new recorded data will get a new time stamp depending on the new defined
location. The geographical data, the time zone and the DST mode are directly linked to the city code. So
also the times for sunrise and sunset may change to unexpected results. This keeps in effect for the
regarded records, even if the citycode is changed again at later times, until these are overwritten by new
cycles (a set of 3442 records). So please take care to avoid this, if you are not quite sure.
To check out the behavior of this function, please first try it out using the ”Change selected city
settings”, because these settings are without any effect to primary device functions.

Changing the citycode
After a click to ”Change local settings” or ”Change second settings” a new window appears, where you can
change the settings for your location.
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First find a city in the list of city names, that is nearest to your own location. Time zone and DST mode
mostly are the same as on your own city. Press ”Transmit new settings” to store the new settings into the
memory of your weather station.
If you are intended, to set your geographical data more precise (has small effects to the calculation of
sunrise and sunset), you may do this using the settings on the right side of the window. Using the button
"Individual location (User/USR)", the data of the selected city are copied to the right side, where they can
be changed. Within the example below, the city settings of Hamburg (HAM) are used as default values.
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Automatically the city code is changed to "User defined city", code name "USR". Now you may change the
settings. To accept the new settings, press the button "Transmit new settings" and the data are stored to
the device, using the code name "USR"..
Attention: Any change of the city, selected from the list of city names, resets the data to default values for
this city. By this way any individual settings for "USR" will be lost.
By using the button “Cancel” all changes are cancelled.

3.3.2.2 Station altitude
Here you may change the altitude, where the station is located. The station measures the
local air pressure at the altitude, where it is mounted and calculates it back to sea level (for
general comparison), using a formula that calculates sea level pressure from local
pressure and the station altitude.
Caution: Changes of the altitude also always changes the measurement values displayed
and recorded within the weather station. So every change of the station altitude will lead to
a sudden transition in curves, showing the process of air pressure.
A good idea is to set the station altitude to a value near the known local altitude and to
adjust it in smaller steps, if sometimes known with higher precision.
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A little bit more precise than setting the altitude itself is the calculation by compare the
measured value to a well known reference value (coming from weather reports on radio, tv
or the internet) for the region. Enter the reference value and press "Calculate". The station
altitude now is calculated from the air pressure difference of the measured value and the
official reference value.
A click to the button ”Transmit altitude settings” will transmit the new settings to the
weather station. Otherwise no action is taken.

3.3.2.3 Time alarms
Here the time alarms are transmitted to the weather station.
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An alarm is activated by setting the alarm time at the desired edit field and get the alarm
switched on by clicking into the desired switchbox. An alarm, if real time agrees to the
alarm setting, leads to a sound and the background light is switched on for a short time.
The weekday alarm is armed every day and stays prepared, even if it is switched off after
an alarm.
The single alarm is armed only one time, until the alarm appears, and than it is switched
off after an alarm.
The prealarm can be activated to execute a prealarm in case of a temperature of 2°C or
below (measured by the external sensor Chn1) to avoid lateness in case of snow or ice.
The prealarm is in effect only, if any weekday alarm is activated. The prealarm can be
executed within a period of 15, 30, 45, 60 or 90 min before the regular alarm time.
The Snooze period defines the period in which the alarm is repeated again, after once
pushing the snooze button on the weather station.

3.3.2.4 Limits for wind alarms and rain alarm
An alarm, if the regarded value exceeds any limit, leads to a sound and the background
light is switched on for a short time. To set an alarm, set the value at the desired edit field
and get the alarm switched on by clicking into the desired switchbox.
Please note: Internally the weather station uses the physical unit mph in a range from 0 to
199.9 mph. If other units than mph are used, alarm values are valid only for settings, that
can be represented as values within this range. The alarm setting calculates a (nearest)
value (in the user defined unit) to the corresponding mph value and shows this (instead of
a value in mph) - looks a litte bit like jumps - but it’s ok.
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To transmit these settings to the weather station, press ”Transmit new settings”. Instead,
nothing happens.

3.3.2.5 Acquisition interval
The acquisition interval, used for the cyclic reading of measurement values to the internal
memory of the weather station, varies from 5 min to 24 h.

To change this setting, select an acquisition interval as desired. Than press “Transmit new
setting”, to transmit the new value to the weather station. Instead, nothing happens.
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Within the info window the calculated recording period for the appropriate acquisition
interval is displayed. Before the calculated date is exhausted, the memory must have been
read to avoid the overwriting of the cyclic memory of the weather station by new values.
The following maximum periods are available with different acquisition intervals:
Acquisition interval

Number of records per day

TFA Nexus (3442 records)

TFA Sinus (208 records)

5 min
10 min

288
144

> 11 days
> 23 days

> 17 hours
> 1.4 days

20 min

72

> 6 weeks

> 2.8 days

30 min

48

> 10 weeks

> 4.3 days

1 hour

24

> 20 weeks

> 8.6 days

1.5 hours

16

> 30 weeks

13 days

2 hours

12

> 40 weeks

> 17 days

3 hours

8

> 1.2 years

> 26 days

4 hours

6

> 1.6 years

> 34 days

6 hours

4

> 2.4 years

> 7 weeks

1 day

1

> 9.4 years

> 29 weeks

3.3.2.6 Status messages
The weather station also sends some information about it’s hardware and other primary
used settings.

These values can only be read, but can not be changed by the program.
The batterie status shows the state of the batteries, used at the external devices. If the
state is ok, a “+” appears, if the battery is low (or link is missing), a “-“ appears.
The eight positions (from left to right) have the following meaning:
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Rain sensor
Wind sensor
Not used
Thermo-/Hygro sensor Chn 5
Thermo-/Hygro sensor Chn 4
Thermo-/Hygro sensor Chn 3
Thermo-/Hygro sensor Chn 2
Thermo-/Hygro sensor Chn 1
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4 Display, Table and Diagrams
The view of current data and recorded data is in three ways:
·
·
·

Display is a virtual copy of the current display of the weather station on the screen
Table shows all (or a part) of the recorded data from the database as a table
Diagrams show all (or a part) of the recorded data from the database as diagrams
· Line diagrams (temperature, humidity, dewpoint, wind chill, wind speed, air
pressure)
· Pie diagrams (statistical data with: wind speed, wind direction)

For the representation of all these views always the physical units (as defined within basic
program settings) are used. They may be different from units, that are displayed at the
weather station itself.
Within the diagrams of the registration card "Display" always the data of the latest 24
hours are displayed. The current values are the values, as the are also displayed and
refreshed every minute at the weather station directly. The minima and maxima also
represent values for the last 24 hours.
With the registration cards "Table" or "Diagrams" the displayed period can be set
individually. By default 24 hours are preset with every start of the program. The selected
period always is shown in the upper ride edge of the window above the button "... Select
Time Slice".

Using the button "... Select Time Slice" the displayed period can be changed.
Time periods backwards from now can be selected as well as also periods within absolute
lower and upper borders.
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The first option allows the selection of a time slice backwards from now in the range of 1 to
100 minutes, hours, days, weeks, month or years (thereby months are always calculated
with 31 days, years always with 365 days).
The second option allows the selection of a precise time slice, wherein the data should be
displayed.

If an explicite time section is not defined, the time slice always is defined in the range from
the first to the last value of the selected section (always from the first to the last day, 00:00
to 23:59). As time sections years, months, days or hours can be specified.
The registration card "Table" always shows, available records only, within the defined time
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slice (records, that are not empty). Within diagrams also empty sections (empty records)
can be included by selection of "Show also empty sections". In this case the time axis
automatic of all the diagrams is switched off.
4.1 Display
Display always shows the latest values read in from the weather station. Deviations
between values, displayed by the program and that, displayed currently by the weather
station may appear within a delay of up to about two minutes.
Additionally to the display of the weather station, some values (temperature, humidity,
dewpoint, wind speed and wind direction) are shown as diagrams within the last 24 h. The
data used for this are records from the database. The diagram of the air pressure within
the last 24 h uses statistical data, coming directly from the statistical area of the weather
station memory.

The view in the window “Display” shows the following measurement values:
·

·

Air pressure
· Current pressure (absolute) on sea level
· Current pressure (relative) local value *)
· Diagram: Process of the last 24 h
Date/Time/Name of the week day (from PC time)
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Data of local station settings (latitude/longitude)
Moonphase (status waxing/wanig/full/new and the visible part of the surface in %) *)
Sun data (sunrise/sunset/high noon and day length) *)
Outdoor temperature, humidity and dewpoint for up to five sensors *)
· Current values
· Minima and maxima
· Diagram: Process of the last 24 h
Indoor temperature, humidity and dewpoint *)
· Current values
· Minima and maxima
· Diagram: Process of the last 24 h
· Comfort range (dry/comfort/wet)
Rainfall
· Total sum
· Diagram: Statistical rain data (last hour, last 24 h, yesterday, last week, last month)
Wind- and gust speed, wind direction
· Current values
· Maxima
· Diagram: Process of the last 24 h *)
Wind chill and wind sensor temperature *)

*) Details:
·

Air pressure:
· The weather station exclusively transmits the absolute air pressure (on sea level) to
the PC. The local value is recalculated from this by using the station altitude. Small
deviatons may appear sometimes.

·

Moon phases:
· The weather station does not transmit any data for the current moon phase to the
PC. The value is calculated by the program from the current date and time, using
also the geographic data.
· The pictures of moon phases, used to give a real impression of how to see
the moon at the current date, are available on the CD “Berliner Mondatlas”,
photographed by members of the “Gruppe Berliner Mondbeobachter” at the “
Wilhelm-Foerster-Sternwarte e.V. Berlin, © 2003 Voigt, Giebler, Tost”. A lot of
thanks for the license, to present these pictures within the program.
· For more informations have a look to
http://www.schule.de/schulen/wfs/Mondatlas

·

Sun data:
· The weather station does not transmit any data for sunrise or sunset to the PC. The
values displayed with the program are calculated from the current PC time and the
geographical data, currently stored at the weather station. Therefore, deviations
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may appear. They are within a range of about +/- 2 min.
Indoor and outdoor temperature, humidity and dewpoint:
· The registration card, showing one of up to five channels selected, can be
switched, using the one desired, from “Chn1” to “Chn5”
· The registration card, showing the process of the last 24 h, can be switched using
the desired card index “Temperature”, “Humidity” or “Dewpoint”
Wind diagram (represented as polar diagram):
· Values, representing the last 24 h, are displayed as small (blue) circles
· Values, representing values within the last 5 min, are displayed as small (orange)
squares
· The current value (value last measured) is displayed as a little bit more sized
(yellow) square
Wind sensor temperature:
· The weather station exclusively transmits the value for the wind chill to the PC. The
wind sensor temperature is recalculated from this by using also the wind speed
value. This works fine with low wind speed values and nearly constant conditions
(only small deviations may appear in case of only a low wind speed or other
pleasent conditions). Clearly higher deviations will appear in case of strong changes
in wind speed or gust speed or in case of any other instable conditions. Please
keep in mind, that the wind sensor temperature can be recalculated with trust only
for pleasent conditions.

4.2 Table
Table shows all (or a part) of the recorded data from the database as a table within the
period, that is selected by the selection box in the upper right corner of the window. The
physical units are these, as predefined at ”Basic program settings”.
The values for the dewpoints, the values for the local atmospheric pressure and the values
for the wind sensor temperature are recalculated by the software.
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The table shows all measurement values of the selected period. The number and the
order of the columns can be changed on demand. To move a column, press the left mouse
button at the headerline of a column, keep it and move the column to the desired position.
On leaving the mouse button the column is placed at the new position and the new order
will be saved automatically.
The first columns date and time are always used. The following columns might be filled
with measurement values or not. If a measurement value is not available (sensor not
connected, missing link, value out of range) the corresponding column or cell is empty.
Empty columns or columns, that should not be displayed, can be disabled by using the
menu point ”File->Program settings->Sensor selection”. Switch off all sensors, that should
not be displayed. These channels will not appear in the table or diagrams again. But, the
values of sensors, that are switched off, are still recorded.

4.3 Diagrams
For the view of diagrams two different representations are used: Line diagrams and pie
diagrams.
The diagrams show all (or a part) of the recorded data from the database within the period,
that is selected by the selection box in the upper right corner of the window. The physical
units are these, as predefined at ”Basic program settings”.
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Line diagrams:
On the first view of a line diagram the minima and maxima of the value axis and the time
axis, as well as the grid lines are set automatically. At the left side you find the grid labels
for the value axis, at the bottom the grid labels for the time axis.
The curves can be switched on or off by clicking to the desired switchbox, shown at the
legend beneath.
Within a line diagram, the left or the right mouse button can be used, to change the
section, displayed (see 4.3.1 Functions using the mouse). As long as the current value is
displayed at the right side of the diagram, it will be refreshed automatically with every
incoming new value. Otherwise the automatic refresh is switched off or, if the condition
mentioned before returns, the automatic is switched on again.
Line diagrams can be displayed as two dimensional or three dimensional (3D) diagrams.
Following the view as two dimensional diagram:

Following the view of the same temperature process as three dimensional diagram:
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Please note: If Zoom is used within 3D diagrams, the startposition of the mousepointer
must be located in the section of the foremost plane. Otherwise no reaction will appear.
Pie diagrams:
With pie diagrams there are no functions to change the section displayed. Pie diagrams
can be displayed as two dimensional or three dimensional (3D) diagrams.
Following the view as two dimensional diagram:
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Following the view of the same data sample as three dimensional diagram:
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4.3.1 Functions using the mouse cursor and keys
With the display of line diagrams a few functions are available by dragging the mouse.
4.3.1.1 Selection with the left mouse key

44

4.3.1.2 Selection with the right mouse key
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4.3.1.1 Selection with the left mouse key
A diagram detail can be selected with the left mouse key held down for enlarged display or
an already enlarged detail can be reset to its original size.
Enlarging a diagram detail
If, with the left mouse key held down, the mouse pointer is dragged from the top left to the bottom right, the diagram is
enlarged on this section when the mouse key is released (with the 3D view the mouse pointer must be located within
the axis scalings on the front plane, otherwise there is no reaction). The automatic axis scaling is switched off.
Resetting the diagram detail
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If the mouse pointer is dragged from the bottom right to the top left with the left mouse key held down, i.e. opposite to
the procedure previously described, then the diagram is reset to its original size when the mouse key is released. The
automatic axis scaling is switched on.

4.3.1.2 Selection with the right mouse key
With the right mouse key held down, the displayed diagram detail can be moved to the left,
right, up or down or it can be compressed or extended in all four directions starting from
the sides and corners. In this respect the start position at which the right mouse key is
pressed determines which action occurs.
Depending on the start position the mouse cursor changes it appearance and shows the
direction of the available move. Five directions are available:
·
·
·
·
·

1. Left to Right
2. Top to Bottom
3. Left Bottom to Right Top
4. Left Top to Right Bottom
5. Move

[1] / [2] Extending or compressing an image detail from the sides:
When the right mouse key is pressed and if the mouse is within a range of approximately 0
- 20% or 80% - 100% in the horizontal or vertical direction (i.e. centrally on one of the
diagram margins), the diagram can be extended or compressed in the horizontal or vertical
direction with the mouse key held down. The automatic axis scaling for the affected axes
is switched off.
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The sections, where the mouse should be located on start of this operation are hatched.
[3] / [4] Extending or compressing an image detail from the corners:
When the right mouse key is pressed and if the mouse is within a range of approximately 0
- 20% or 80% - 100% both in the horizontal and vertical directions (i.e. in one of the
diagram corners), the diagram can be extended or compressed in the horizontal and
vertical directions with the mouse key held down. The automatic axis scaling for the
affected axes is switched off.

The sections, where the mouse should be located on start of this operation are hatched.
[5] Moving an image detail:
When the right mouse key is pressed and if the mouse is within a range of approximately
20% to 80% in the horizontal or vertical direction (i.e. in the central part of the diagram),
the diagram can be moved in the horizontal or vertical direction with the mouse key held
down. The automatic axis scaling is switched off.
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The section, where the mouse should be located on start of this operation is hatched.

4.3.2 Printing of Diagrams
After selection of the print function using the menu point File->Print a new window
appears, showing a print preview of the currently displayed diagram.
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Orientation Selection of the paper format Portrait or Landscape
Margins
Setting the page margins left, top, bottom and right
Detail
Changes the resolution of the diagram displayed
ProportionalUses the proportions of the diagram as shown on the screen
Smooth
Smoothes the diagram view to fit to a higher printer resolution
Printer
Setup
Print
Close

Selection of the printer to be used
Setup of printer functions in detail
Start printing
Close the print preview without any actions

A click to the button “Print” starts the print out of the diagram, a click to the button “Close”
leaves the print preview without any actions.
To print a diagram, always the pure diagram surface is used. Exeptions are the printing of
the combined wind / wind direction diagram, the printing of the table and the printing of the
virtual display. These are always printed as hardcopies from the screen.
You may use this printing tool also to print hardcopies of screen shots, made by using the
key combinations “Alt-Print” (active window) or “Print” (full screen). Press “Ctrl-P” to get
access to the printing tool and the latest hardcopy will appear to be printed.
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5 Using the data with third party programs
The data recorded from the weather station are saved to the file ”NexusOrg.dbf” at the
directory ”Programs\TFA_Nexus\Data” (or to the directory you desired).
The data format is the ”dBase III” format, supported by many programs widely distributed
(i.e. MicrosoftÒ ExcelÒ). The file ”NexusOrg.dbf” can be opened by these programs for
own evaluations.
Please note: Never save the file “NexusOrg.dbf” using a third party software, even
not by using ExcelÒ. This is, because of some file settings may be damaged and
this may lead to serious problems on operating the software TFA Nexus. To edit,
always use a copy of this file.

5.1 Example: Import to MicrosoftÒ ExcelÒ
To import the file ”NexusOrg.dbf” into MicrosoftÒ ExcelÒ, two procedures are usual:
Please make a copy of ”NexusOrg.dbf”, i.e. ”Nexus001.dbf”, before saving any changes.
Please note: The following pictures are taken from the german version of excel. The appearance of excel with
other languages is similar.

1) Start the program MicrosoftÒ ExcelÒ. Open the copy ”Nexus001.dbf” by selection of
Menu->File->Open and set the file format, available at the selection box ”Data type” to ”dBase files”.
Change to the directory, where the file is located, click to the filename ”Nexus001.dbf” and then click to
the Button ”Open”. The file will be loaded.

TFA Dostmann GmbH & Co.KG

50

TFA Nexus

or
2) Start the Explorer and change to the directory, where the file is located. Open the file by a double click
to the filename ”Nexus001.dbf”. (If ”dbf” is not registered so far by the system, you will get a list of
programs and will be asked to point to a program, that is able to open ”dbf”. Search for the program
MS-Excel and click to this).

The file ”Nexus001.dbf” will be opened and displayed in a MicrosoftÒ ExcelÒ sheet.
Processing the file loaded:
After loading the file, it appears using the MicrosoftÒ ExcelÒ table sheet format..
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As column headers you will find the names of the appropriate fields.
At the most left you will find the column named ”DATE_TIME”. This column holds the date and time,
encoded as floating point number. To get a real date and time display, proceed as follows:
Mark the whole column by a click to the column header named ”A”. Click to a point anywhere in the marked
section, using the right mouse button. A popup menu will appear.

From this popup menu select the line ”Format cells”. A new window appears. From this window select the
category ”Date” and the desired date/time format. Click to OK.
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The most left column changes it’s view and shows the date and time, as desired.

From now on you may proceed with Excel as usual.
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6. Database Check and Repair
Within a time of experience with the software and the weather station some circumstances
have been cleared up, how bad records could have found their way into the database
("NexusOrg.dbf" resp. "SinusOrg.dbf").
Some reasons are:
· On the first start of the software still "non initialized" values from the weather station
were taken for good and stored to the database
· On the first start of the software (first reading takes about eight minutes) the
transmission was interrupted by the user or other circumstances
· On future trials some records could have been read twice or multiple and stored to the
database
· On any starts after a reset of the station the initialization date 01.01.2005 (that is not
valid in this case) was taken for good and stored
· On editing the database using third party programs the structure of the database could
have been changed (and thereby destroyed)
· On reading records with system settings other than "german" the decimal separator ","
instead of "." could initialize an "floating point error" on reading the database
· ... different other circumstances, that were analyzed and have been found to be possible
sources for future mal functions
The reasons for some mal functions are checked well since version 1.3 and should be out
of matter for the future use.
The module for Check and Repair will fix a lot of effects to the behaviour of the database
and recognizes and excludes their reasons automatically.
Using the menu point "Help->Database Check and Repair" the tool (TFA_Check.exe) can
be started.

Starting the tool the connection to the weather station will be switched off and the online
program will be closed. Thereafter the Check and Repair tool appears with its starting
window:
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6.1 System Language Settings
In many cases it was not quite clear, what Language settings were used by the system (this information was
helpful to check the curious floating point behaviour). Therefore the tool also allows to show the internally
used constants, depending on the system language settings (but this feature is not necessary to check or
repair the database).
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6.2 Checking the database *.dbf
In the box "Check TFA datafile *.dbf" the check routine can be started. The preset database filename, as
used by the online program ("NexusOrg.dbf" resp. "SinusOrg.dbf"), is used as default. If copies or renamed
backups are available, they also can be checked and repaired.
After pushing the button "Start" the check window opens:
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Press the button "1. Start", to start the check routine. The program now executes six check sections, one
after the other, and finally it evaluates the results. If warnings or errors occured, you will be asked to
execute also the second step "2. Repair".

TFA Dostmann GmbH & Co.KG

6. Database Check and Repair

After the repair procedure the file will be checked once again and the result should be free of any warning
or errors (some times more than one leap is necessary, i.e. to fix the beeing of multiple records).
Using the button "Show Table" you can display the contents of the database as an overwiev.
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After a successful repair a backup file of the original database is created an the original file is replaced by
the repaired. After this you may leave the tool and restart the online program again by pushing the button
"Close and restart TFA program".

6.3 Concatenate to only one database
Some users asked for a tool to concatenate database files (as earlier created backup files) to only one
original database, that then ca be used as a new original database by the online program. This can be
done, using the box "Concatenate to only one database". After pushing the button "Start" a new window will
open:
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Using the button "Select files" all files, that are planned to be concatenated, can be select. To select files,
press down the "Ctrl"-key and click to every file, you want to add.
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After confirmation the database files are listed, showing their name, the first and last date of the records
and the number of records:

If any records are completely overlapping, you may exclude these files. But, the following check routine
also excludes twice or multiple existing records (only the time for checking needs to be a litte bit longer).
To concatenate the selected files, now press the button "Start". All records are concatenated to a temorary
file "Concat.db$". After this, also all multiple records are still included. At least the following check excludes
all multiple records from "Concat.db$". To start the check routine press the button "Check file":
After a successful check (in some cases more than one leap is necessary to exclude all multiples) you may
use the file "Concat.db$" as new original file "NexusOrg.dbf" (resp. "SinusOrg.dbf") for the online program.
To do so, press the button "Execute". This creates a backup file of the earlier original file and then it
replaces the original file by the freshly created "Concat.db$".
At least you may close the window, leave the tool and restart the online program.
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Program Updates
Since the first release Version 1.0 (coming in december 2006) some program updates have been
proceeded.
These i.e. are:
·
·
·
·

Debugging and removal of a few program operation errors
Consideration of some customer hints
Improvement of the service capabilties
Preparation of new functions

Program updates are available for download from the TFA-Website. The link to the appropriate site is:
http://www.tfa-dostmann.de/download.asp
The manuals for the weatherstation also are available for download in the download area, using the link:
german: http://www.tfa-dostmann.de/Bedienungsanleitungen/351075_g.pdf
english: http://www.tfa-dostmann.de/Bedienungsanleitungen/351075_e.pdf

7.1 Versions Informations
Update informations (processed changes, latest always on top):
Version V1.3 (29.09.2008)
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

29.09.08 Release V1.3 (Version 1.3.1 Build 392++) for Sinus/Nexus
Station altitude now adjustable also by reference
User settings (USR) simplified by copying default settings from standard city codes
Prealarm settings (temperature prealarm) appended to time alarm settings
Calculation of storage capacity while setting the acquisition interval
Repair tool (TFA_Check.exe) appended (check or concatenate databases, display of language settings)
Faster diagrams painting by direct access to the database (instead of accessing a temporary table)
24h Min/Max values now always calculated exclusively from database records
Show station holded Min/Max in its own, separated window
Time slice settings for hours, weeks, months, years and absolute margins (from ... to) appended
Offline display now uses the geograpical settings of the station from the GeoData.ini file
Invalid values of air pressure (coming i.e. while changing the station altitude settings) will be cancelled
Helpfiles (.hlp) and manuals (.pdf) now always with identical conents
Invalid values (coming i.e. from the initialization period of the station) will be cancelled
Automatic reconnection after loosing the USB connection (devcon.exe)
Integration of the planned station TFA Sinus, Software now supports Nexus and Sinus
With diagrams now Minima and Maxima are only processed from the visible data
Small changes of the user surface (frames, font, logo, colours) with the view "Display"
New statusbar at the bottom of the window with progressbar and some detailed informations
Faster finding and reading of the appropriate EEprom sections
Arrangements for multilanguage using (includes new Language_E.ini)
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· Debugging and removal of the floating point error (often coming with other then german language
settings)
Version V1.2 (21.05.2007)
·
·
·
·
·
·
·
·
·

Release V1.2 (Version V1.2.1, Build 256)
Printing with rain diagram changed to a double view diagram
Rain display extended by a new diagram with daily rainfall quantity
High resolution / fast diagram display now switchable
Faster diagram display for data within 24 hours
Columns of the table now moveable
Introduction of an Offline operation mode and small changes of the surface
Faster access to records of the database
Date and Time formats changed to international demands

Version V1.1 Build 248 (E, 02.03.2007)
· Special version of TFA_Nexus.exe V1.1 Build 248 (E), delivered to some english customers (bug with
some datetime formats)
Version V1.1 Build 242 (14.02.2007)
·
·
·
·
·
·
·

Settings capabilities appended for the program and the device, channel colours
Hiding of non used columns of the table
Display hour glass, while communication is running
Wind history diagrams extended by a selection box for wind and gust
Extension to english version (program surface, documentation and manual)
Progressbar now available on reading EEprom data
Some changes of address contents with the window "Version Info"

Version V1.0 (12.12.2006)
· Version 1.0 (only german) released

TFA Dostmann GmbH & Co.KG

Stichwortverzeichnis

Stichwortverzeichnis

Help

15, 17

-I-\\Data

Import 49
Installation 6, 8

-K-

49

-C-
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-MManual 6
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Menu bar 14
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Mouse 6

-DDesktop 9
deviations 18, 19, 20
Device 4, 7
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Diagrams 35, 47
Display 18, 19, 20, 35
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Operating system 6
Operation instructions

-FF1 17
File 15
First start 10
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6
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-P9

PC 6
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Pie diagram 35
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Preparations 9
Preview 15, 47
Print 15, 47
Print preview 47
Program manager 9
Program settings 24, 25
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program start 8
progress bar 10
Pulldown 14

-QQuit
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-RRead data 15
Registration card 14
Requirements 6
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Software 7, 8

24, 25
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User interface

14
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